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In drug discovery we are faced with many challenges as we look for compounds that have the right 
balance of properties in order for them to become successful drugs. In the early hit-to-lead stages we 
often wish to explore a wide range of chemistry in order to find those areas of chemical space which 
contain lead series with the greatest potential. As we move into lead optimisation we need to focus 
more closely to learn about the structure-activity relationships (SAR) and design new ideas around 
specific scaffolds. In this first section we will become familiar with the StarDrop interface and touch on 
a number of these themes. 

 Gaining familiarity with the StarDrop interface 

 Importing compound data 

 Calculating simple properties for compounds 

 Visualising data 

 Using Card View™ 

 Open the project file 5HT1A library.sdproj.  

 

1. Which chemistry has the highest average potency? 

Answer:__________________________________ 

2. What is the identifier of the most potent compound?  

Answer:__________________________________ 

Hint: Sort the data set by pKi in descending order by right-clicking on the 5HT1a affinity (pKi) 
column, as shown below: 
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Initially, we will explore the relationship between the measured potency (pK i) and simple ‘drug like’ 
properties of the compounds in this library. We are going to calculate some properties and then use 
the visualisation tools to find a chemistry that meets a number of property criteria. To do this, use the 
following steps: 

 Select the following properties in the Models tab: logP, MW, HBD, HBA, TPSA and Rotatable 
Bonds. 

 

 Calculate these properties for all of the compounds in the data set by clicking the  button. 

 In the Visualisation tab, click the  button to open another plot window. 

 In the new window, plot a 2D scatter plot of 5HT1a affinity (pKi) against logP by clicking the  
button and selecting the properties from the X: and Y: menus, as shown below: (Alternatively 
you can hold down the Ctrl key while selecting these two columns in the data set) 
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 Now colour the points by TPSA and size the points by HBD. 

Hint: Click on the colour block in the key 
(indicated by the arrow in the screenshot above) 
to display the Format by Property dialogue box 
and choose TPSA from the Source: menu, as 
shown right. Click on the Size tab in the dialogue 
box to size by HBD in a similar way. 

 

 

 

 

 

 Finally, change to the Filters tab in the plot window to remove points from the plot which have 
MW greater than 300. Click the Add button and choose MW to create a new filter and then 
adjust the range as shown below: 



  6 

 

 

 Select a region in the bottom right corner of the plot. 

3. Which chemistry includes the majority of compounds with high potency, low MW and 
appropriate logP values? 

Answer:__________________________________ 

Let’s take a closer look at the ranges of properties across the different chemical series in this data set. 

 Click the  button to switch into Card View. 
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 Click the Design button and choose Custom… 

 

 Click the Open button to load the 5HT1a Card Template. Now click OK. 

 We can easily compare representative, potent compounds from three different series. Move the 
Card View table top down by clicking in the empty space between cards and dragging down. 
Now move the 2nd, 3rd and 4th cards up into the space above, next to each other. 
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 Zoom in (using the mouse-wheel or the Ctrl + = keys) to take a closer look at their properties. 

 

 Toggle the property pages to compare their different properties by clicking the circles at the 
bottom of one of the cards. 

4. All three compounds are very potent so on the basis of these three examples which chemistry 
type looks promising as a potential lead? 

Answer:__________________________________ 

 Change to the third page and add a note for compound S1-9 indicating that this compound has 
potential. 

Hint: Click on the third circle on the card and then double-click in the Add Notes… field. 

 Click the  button to colour the cards. In the Colour By dialogue choose the property 5HT1a 
affinity (pKi). 
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 Click OK. 

 Using the mouse-wheel (or the Ctrl and – keys) zoom out again and then from the Layout menu 
choose Grid. 

 

Our data set is already sorted with the most potent compounds at the top. 

 Once again, select a region in the bottom right corner of the scatter plot to see the associated 
cards. 

 We are now going to take a look at the properties of each chemical class (as indicated by the 
“Chemistry” column in the data set) so from the Organise menu choose Stack -> By Property…. 

  

 In the Stack by Properties dialogue choose “Chemistry”. 
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 Click OK. 

 

5. Which stacks appear to contain compounds with the best ranges of potency and logP values? 

Answer: _____________________________________  
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In hit-to-lead, it is important to quickly focus resources on the chemistries that are most likely to yield 
a high quality lead series. In this example we will explore how data from primary screening of a library 
for potency against the target 5HT1a can be combined with predictions for a range of ADME and 
physicochemical properties to identify chemistries with a good balance of properties. At the same time, 
given the uncertainty in the underlying data due to experimental variability and statistical error, it is 
important that we do not reject compounds inappropriately and risk missing valuable opportunities. 

 Using predictive ADME QSAR models 

 Creating and using scoring profiles 

 Interpreting scores 

 From the File menu choose Close Project (Discarding any changes) and open the file 5HT1A 
library pKi.txt.  

 

 Confirm the text delimiter that has been used to create this file (Tab) and click Next. 

 As we import the data, we are going to provide some additional information about the 
experimental values we are importing. Select the 5HT1A affinity (pKi) column in the import tool. 
Set the units of the experimental pKi data to pKi/pIC50 and the uncertainty to 0.3 log units 
(equivalent to a factor of two in the Ki).  
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 Click Finish to complete the data import. 

 On the Models tab select all the StarDrop models and click the  button to run them.  

 Change to the Scoring tab and select the Oral CNS Scoring Profile, listed under Saved profiles, 
as shown below: 

 

 Add 5HT1a affinity (pKi) from the list of Available properties to the scoring profile by dragging 
the property into the profile editor. Set a Desired Value of >7 and an Importance of 0.95 for this 
property, as shown below: 
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 Give the resulting profile a name by entering it in 
the Profile: box above the scoring profile and 
save it in a convenient place by clicking on the 
Save button below the scoring profile and 
choosing Save to File…. It will appear in the list of 
scoring profiles at the bottom of the Scoring tab, 
so that you can retrieve it easily. 

 

 

 Run this scoring profile by clicking on the  button in the Scoring tab and answer the following 
questions: 

6. What are the most critical issues that should be addressed to significantly improve the chance 
of success of compound S3-23? 

Answer:__________________________________ 

Hint: Use the Find tool (the  button on the toolbar) to locate compound ID S3-23. 

7. Which compound has the highest score? 

Answer:__________________________________ 

Hint: Sort the data set by score in descending order. 
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 Generating and visualising chemical spaces 

 Considering uncertainty when selecting compounds 

 Exploring an appropriate balance of quality and diversity 

 Change to the Visualisation tab. 

 Click the chemical space button . 
Click Create... to create a new chemical 
space. In the Create Chemical Space 
dialogue, give the new projection a name 
of 5HT1a Space and then use the default 
settings, as shown to the right, to 
generate a chemical space based on 
chemical structure alone. Click OK to 
generate the chemical space plot.  

 Click the detach button  on the 
Visualisation tab to create a separate 
window containing the chemical space 
plot, as shown below: 

 

 

 

 By clicking on the colour block in the key of the detached plot, colour the points by the overall 
score, as shown below: 
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Hint: You can change the background colour on the plot by right-clicking on the plot and 
selecting Change Background... 

8. Which chemistry contains the majority of the top 10 compounds? 

Answer: __________________________________ 

Hint: Selecting points from the chemical space will select the corresponding compounds in the 
data set and vice-versa, as illustrated below (Please note, the selection shown below is not the 
top 10!): 

 

 Select the scoring column to generate a Snake Plot for the compound scores in this library, as 
shown below: 
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 Points in the Snake Plot for which the error bar overlaps with that of the first compound cannot 
be confidently distinguished from the highest scoring compound, based on the selected scoring 
profile and the uncertainty in the available data. By selecting compounds with an appropriate 
range of scores from the Snake Plot, as illustrated below, answer the following question: 

9. Which other chemistries should we consider in the search for a high quality lead series? 

Answer:______________________________________________________________________
_____________________________________________________________________________ 
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The chemistries we have been referring to in this data set (in the Chemistry column) were predefined, 
however, we can use StarDrop’s analysis tools to cluster our compounds based upon their structures 
or properties. 

 Switch back into Card View by clicking the  button. 

 From the Analyse menu choose Clustering. 

 

 Select Common Substructure and then click the Cluster button. 

 

 Right-click on a stack and choose Inspect from the menu. This enables us to browse the cards in 
this stack and, if necessary, remove cards, simply by dragging them out of the window. 
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 Click the   button and colour the cards by the overall score – interpolating from 0 to 0.3. 

 

 We can see that the Aminotetralines generally have the best overall scores, but we’d like to 
refine the clustering results to combine the three stacks which contain Aminotetralines with 
common sub-structures (highlighted above) by dragging one on top of the other. 

Note: On some computers this display may be rotated but the Aminotetralines we’d like to 
combine are highlighted above.  

The newly combined stack will show the common sub-structure of all the compounds in the three stacks 
that we have combined. This flexibility enables us to ‘fine tune’ the layout based on our understanding 
of the chemistry. 
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One of the chemical series chosen for progression from the hit-to-lead project, explored in the previous 
section, was a series of Arylpiperazines (series S10). Due to their similarity with the drug Buspirone, 
which is known to have issues due to rapid metabolism by Cytochrome P450 CYP3A4, the compounds 
were initially tested for stability against this P450 isoform. 

In the following example, we will explore approaches to investigate the structure-activity relationships 
(SAR) for these properties along with additional predicted properties. Furthermore, we will see how the 
Glowing Molecule visualisation can help to guide the design of compounds to overcome potential 
liabilities, while monitoring other properties to ensure that improvements to one property do not have 
a negative impact on other important factors. 

 Exploring the activity neighbourhood 

 Generating R-group decompositions 

 Visualising Structure-Activity Relationship (SAR) tables 

 Multi-parameter optimisation within a chemical series 

 Open the file Arylpiperazine series S10.add containing 21 compounds from series S10, for which 
both potency (pKi) against the 5HT1a target and half-life for metabolism by CYP3A4 have been 
experimentally measured. 

 Switch into Card View by clicking the  button. 

 Using the Find tool (the  button on the toolbar) locate compound S10-14 and select it. 

 We are going to take a quick look at whether there might be some interesting SAR to explore 
and so from the Card View Analyse menu select Activity Neighbourhood. 

 

 Choose to colour the links by the difference in potency - 5HT1a affinity (pKi) 
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 We will use the defaults for all of the other settings, linking the 10 most similar compounds to 
the reference we chose. This will help us to find any ‘activity cliffs’, where a small variation in 
the compound structure has a large impact on the potency. Click OK to run the analysis. 

 

The compounds are laid out in a spiral with our chosen compound at the centre and the most similar 
compounds close to it. Bright red arrows show the most significant increase in potency. 

10. Which variations in chemical structure have the greatest impact upon the potency? 
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Answer:______________________________________________________________________ 
_____________________________________________________________________________
_____________________________________________________________________________
_____________________________________________________________________________ 

Hint: Hover the mouse over the reddest links (i.e. the links which indicate the greatest change 
in potency) 

 

To further analyse the SAR in this series and explore the different contributions of the various 
substituents and linkers to both the potency and metabolic stability we will carry out an R-group 
decomposition.  

 Change back to the Table View by selecting the  button on the toolbar. Select the row 

containing Buspirone and click the Run R-group Decomposition button  on the toolbar. 

 First, we will define the regions representing the common scaffold within the chemical series. 
Select the two ring functionalities, highlighted in blue below, by drawing around them to lasso 
the area and then holding down the Ctrl button to select a second region. 
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 Click Next to confirm the R-Groups that will be analysed. In this example, the scaffold represents 
two separate regions, so the connecting group will be considered to be a variable linker. 

 

Hint: Although it is not necessary in this case, you can indicate additional R-Groups by selecting 

the  button and then clicking at the point on the scaffold where they should be included. If 

you wish to specify variable atoms or fragments within the scaffold, click the button and 
then select atoms on the scaffold which may vary between the compounds in the chemical 
series. 

 Click Next to enter a name for the analysis and then the Finish button. New columns will be 
added to the data set indicating the R-Groups and linkers that have been found for each 
compound, as shown below: 

 

 With the Visualisation tab selected, plot R3 of the SAR analysis against the linker L1 to generate 
a SAR table, as shown below: 
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Hint: You can do this by clicking the SAR plot button  and selecting R3 from the X: menu and 
L1 from the Y: menu in the Visualisation tab or simply selecting the headers of the corresponding 
columns in the data set (holding the Ctrl key to select multiple columns) 

 Colour the circles in the SAR plot by the potency, 5HT1a 
affinity (pKi), by clicking on the colour bar in the key 
next to the Arylpiperazine series S10 data set, as shown 
right. Size the circles by the stability, CYP3A4 T1/2 
(min). 

11. Which groups at position R3 and linker L1 give the 
highest potency? 

Answer: ___________________________ 

12. Which group at position R1 and linker combination give 
the highest stability against CYP3A4 metabolism? 

Answer: ___________________________ 

 Click the detach button  to create a separate 
window containing the SAR plot for future comparison. 

We would like a balance of potency and metabolic stability, so we’ll use Probabilistic Scoring to help us 
to identify the substituents that are most likely to achieve a good balance of these experimental 
properties (and other predicted properties).  

 Change to the Scoring tab and select the scoring profile we used earlier, in the Hit-to-Lead 

example. If you do not have the scoring profile in the list of Saved Profiles:, click the  button 
and open the scoring profile file called Potent + Oral CNS Scoring profile.apd 
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 Add the CYP3A4 T1/2 (min) property to the 
scoring profile by dragging it from the 
Available properties: list into the profile 
editor, as show to the right. 

 Ideally, we would like a half-life of > 20 
minutes, but we may be willing to accept a 
lower half-life if other properties are ideal, so 
we will set up scoring function with a trend for 
this property. Select the CYP3A4 T1/2 (min) 
property in the scoring profile and click Edit. 

 In the scoring function editor that appears, 
click Insert to insert a range from 0 and 20, 
with a score of 0 for T½ = 0 and a score of 1 for 
T½ = 20, as shown below. Ensure that the score 
for T½ below 0 is set to 0 and for T½ above 20 
is set to 1, as shown below. Click OK when you 
have finished. 

 Give the resulting profile a name by 
entering it in the Profile: box above the 
scoring profile and save it in a convenient 
place by clicking on the Save button below 
the scoring profile and choosing Save to 
File…. It will appear in the scoring profile 
list at the bottom of the Scoring tab, so 
that you can retrieve it easily. 

 Run the new scoring profile by clicking on 

the  button.  

 

13. Which compound is most likely to have a good balance of potency, metabolic stability and the 
other properties required by this project? 

Answer:__________________________________ 
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One of the potential issues identified for this chemical series is inhibition of the hERG ion channel, 
indicating a risk of QT prolongation and cardiotoxicity. Therefore, we will use the interactive designer, 
guided by the Glowing Molecule, to explore potential strategies to reduce the predicted hERG pIC50. 

 Loading additional predictive models and scoring profiles 

 Using the interactive designer 

 Interpreting the Glowing Molecule 

 Change to the Models tab, click the  button and select the model 
5HT1a_pKi_Arylpiperazine_local_model.aim. This will appear in the list of models under the 
branch called StarDrop Training Files, as shown below: 

 

 Now we will load a new scoring profile that uses this model. Change to the Scoring tab, click the 

 button and select the scoring profile Potent + Oral CNS Scoring Profile all predicted.apd. 
This is the same as the profile we used earlier, using predicted values of the 5HT1a pKi in place 
of experimental pKi (but not CYP3A4 stability, because a model is not available for this property).  
We will explore strategies for optimisation of stability with respect to P450 metabolism in the 
P450 exercise later (if applicable). 

 Score the compounds using the new profile by clicking the  button. 

 To help us to get an overview of each compound’s properties change to the Molecule View by 

clicking the  button on the toolbar. Find compound S10-14, which is the highest-scoring 

compound (Hint: use the Find tool  on the toolbar). Click on the hERG pIC50 model result 
to display the Glowing Molecule for this property, as shown below. 
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 Change to the Design tab to explore strategies to reduce the potential for hERG inhibition. Select 
the displayed structure in the molecule view and it will be displayed in the editor. When the 
hERG pIC50 prediction is selected, the Glowing Molecule will also be displayed, as shown below:  

 

 

 

 

 

 

 Edit the structure, as shown below:  

 

14. What effect does this have on the predicted hERG pIC50? 

Answer: __________________________________ 

15. What effect does this have on the overall predicted score? 

Answer: __________________________________ 

16. Why? 

Answer: __________________________________ 

 Try the structure below instead, replacing the phenyl of compound S10-14 with a pyrole: 

 

Hint: To quickly delete the phenyl ring in the previous compound, draw around the phenyl ring 

with the  tool and type Ctrl-X. 

17. What effect does this have on the predicted hERG pIC50? 

Answer:__________________________________  

Red regions have a 
tendency to increase the 
value of the predicted 
property. 

Blue regions have a 
tendency to decrease the 
value of the predicted 
property. 
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18. What effect does this have on the overall predicted score? 

Answer:__________________________________ 

 Add this compound to the data set by clicking the  button below the editor. If you wish, you 
can give the compound a name by double-clicking in the Name cell. 

Feel free to explore some additional ideas for how to reduce the predicted hERG pIC50 without having 
a detrimental effect on the overall balance of properties. In a later exercise (if applicable), we will 
explore how the Nova module in StarDrop can help to automatically explore a large number of ideas to 
identify those most likely to give a good balance of properties. 
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 Using the P450 models 

 Interpreting regioselectivity results 

 Understanding the metabolic landscape and composite site lability 

The P450 tab provides models for the prediction of the regions of your compounds that are most 
vulnerable to metabolism by the major drug metabolising isoforms of cytochrome P450. These models 
provide guidance for the redesign of molecules to overcome metabolic liabilities and also to identify 
molecules with a high risk of rapid metabolism by Cytochrome P450 enzymes. 

(Note: The results of these models are only relevant if the compound is a substrate for the specific 
isoform - these models do not give any information about whether or not compounds are substrates) 

The exercise below is designed as an introduction to these tools and illustrates the effect of chemical 
modification within a chemical series. 

 Open the file P450analysis.add containing compounds S1-45, S8-17 and S6-31 

 From the P450 tab, run the P450 models on these compounds by selecting all three rows and 

clicking the  button. You can select a complete data set by clicking the button at the top left 
of the table or by pressing keys Ctrl-A. 

 

While the calculations are running an indicator will be displayed in the P450 column showing the queue 
position for each molecule or whether it is being calculated. Once a result is complete it will be returned 
and displayed in the row. Clicking on that row enables you to see the results in the P450 tab. 
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19. Complete the table for each compound inserting the CSL and the site(s) most likely to form at 
least 50% of products due to metabolism by CY3A4? 

Compound CSL Likely Site(s) of Metabolism 

S1-45   

S8-17   

S6-31   

 Select compound S1-45, modify it to form the following three compounds and add them to the 
data set: 

(Hint: Go to the Design tab, click on the row containing S1-45 and edit it to create each 

analogue in turn. To add the edited molecule to the data set click the  button) 
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Compound Structure 

Analogue 1 

 

Analogue 2 

 

Analogue 3 

 

 

20. The P450 models predict the vulnerability of each site to metabolism by CYP3A4. Which of the 
above compounds is most likely to show an improvement in metabolic stability over S1-45? 

Answer: ___________________________________________________________ 

(Note: If you select a compound that’s already queued, the  button will change to  
indicating that clicking the button again will remove the compound from the queue.) 
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 Using the Auto-Modeller wizard to build models 

 Changing the Auto-Modeller settings 

 Building continuous and category models 

 Viewing, saving and using new models  

Your project has measured some affinity data for the target you are working on. The compounds already 
synthesised and measured show a spread of affinities across a number of different chemotypes. In 
order to use this for decision making about new compounds to be synthesised it is necessary to build a 
model of this data that can be used alongside the ADME models. Your project has recently measured 
the affinity for the target for a small number of further compounds and these will be available to test 
the models built with the original set of data. 

This exercise uses the Auto-Modeller tab and the Mathematical Function Editor in StarDrop. 

 Open the file AffinityData.txt, click Next to confirm that it is a tab-delimited file. 

 Select the Affinity Ki(µM) column, tick the Use default value for all data option and specify the 
uncertainty value to be a factor of 10. 

 

 Open the Mathematical Function Editor by clicking the  button and create a function to 
convert the Ki values into pKis in a new column called pKi. The Ki values are µM and so the 
function is: 

-log({Affinity Ki(uM)}/1000000) 
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 On the Auto-Modeller tab start the Auto-Modeller wizard by clicking the  button. 

 On the first wizard page, accept all the default settings but change the Value Column: to be pKi. 

 

 Click Next until you reach the Select Methods page. Here, un-tick all the Intensive methods. 

(In practise you would normally use all these methods for a data set of this size, but for this 
example we will just use the quicker methods). 
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 Click Finish to start the model building process. 

 Once the process has completed, select the session to see statistics for all of the models. 

 

Hint: To see a graph of the model results for an individual model, select the model in the list. 

21. Complete the following table and then comment on the differences: 

Model 
Training Validation Test 

R2 RMSE R2 RMSE R2 RMSE 

PLS       

GP Fixed       

GP 2D Search       
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RBF       

Random Forests       

Comments:______________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

____________________________________________________________________________ 

(Hint: To see the Test results for all models ensure Test best model only is not ticked in the Auto-

Modeller preferences) 

 Start the Auto-Modeller wizard again. Change the Model Type to Category  and once again 
change the Value Column: to be pKi. 

 

 The input data (pKi) is numerical and so this time when you click Next, you'll be prompted to 
define categories. The default values will show the average value as the cut-off but if you double-
click on this you can change the value to 5. 
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 Click Finish to start the model building process. 

22. Which is the best model and how does it compare with the others? 

Answer:______________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________ 

 Save the best continuous and classification models by right-clicking on them and choosing Save 
Model... from the menu.  

 Open the file AffinityData2.txt and in the Import Text File dialogue click Next and Finish. 

 From the Models tab, run the best continuous and the best category model against this set of 
compounds. (Hint: the saved models will appear in the Custom section). 

23. Comment on how well these models performed and which might be most useful when making 
decisions about which compounds to synthesise in the future: (Don’t forget to apply the same 
function to convert the Ki values into pKis before you compare them with the models.) 

Comments:____________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________ 
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 Using Nova to generate new compound ideas 

 Controlling the way new molecules are generated 

 Exploring Nova results 

Company X has found a lead compound which they would like to try and evolve into a candidate. The 
compound has a good profile of ADME properties but insufficient inhibition of the target (Serotonin 
transporter). Your task is to see if you can generate some new ideas for compounds which can improve 
the potency while maintaining the balance of other properties. 

We will use a model for Serotonin transporter inhibition built with public domain data from the ChEMBL 
database using StarDrop’s Auto-Modeller to monitor potency during the exploration. 

Nova is capable of generating data sets of many hundreds of thousands of compounds if left to run for 
many generations and so for this exercise we’re going to take a look at how we can manage this. 

This exercise uses the Models and Nova tab in StarDrop. 

 On the Models tab, right-click over the models and select Open Model… from the menu and 
then open the model file Serotonin_Transporter_logKi.aim 

 

 The model will appear in the Custom model section. 

 Open the data file Nova lead compound.add 

 Select the only row in the data set and on the Nova tab, click the  button to start the Nova 
wizard. (Hint: like the P450 models, when you start Nova it only applies to those rows which are 
selected). 

 The Nova wizard can be used for idea generation and library enumeration. In this example we 
are going to select Nova Ideas Generation. Click Next. 

 On the Specify Input Structure page of the wizard, select the naphthol group, by drawing around 
it, to ensure that this is not modified during the process. 
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 Click Next to go to the Select Transformations page. Nova will search for, and display, only those 
transformations which are applicable to the input structure. However, if you are going to allow 
Nova to run for multiple generations (as we will in this example) it is sometimes useful to select 
additional transformations. These cannot be applied to the first molecule, but may be applicable 
in subsequent generations. Click Show all to display the complete list of transformations 

 

(Hint: selecting an individual transformation will enable you to see an example along with any 
other available details). 

 For this example, we are going to limit Nova to a small number of transformations. Select just 
the following groups: Ring addition, Ring modification and Ring removal. 
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 Click Next to go to the Control Output page. Change the number of Generations to 3 and tick 
the Compound Selection box. Choose to select compounds with High Serotonin scoring profile. 
Choose a Biased selection with a weight of 1 on Value (in this example we will not search for 
diverse solutions). From each generation select The best 15 compounds. 

(Hint: You don’t have to specify any criteria when running Nova. However, beware that with just 
200 transformations, running it for three generations without any limiting criteria can produce 
data sets with over 1,000,000 compounds – which could take a little while.) 

 

 Start the process by clicking Finish. The Nova job will take a couple of minutes to run… 

 While in progress an indicator will show the highest score that has been achieved so far. Once 
complete, a new data set will be displayed using Card View. 
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A radial network will be displayed with the initial compound at the centre and each subsequent 
generation in a ring around this.  

 You can easily see this by clicking on the colour palette ( ) and colouring the cards by 
Generation. 

 

The links between the cards indicate that a transformation was applied, with the arrow indicating the 
resulting molecule. The links are coloured such that red indicates a transformation which increases the 
score and blue indicates a transformation which decreases the score. We can see that in this network 
the highest scoring compounds were found in the second generation because most of the links to the 
last (third) generation of ideas are blue. Where there are multiple links to a compound, or links between 
compounds within the same generation, this shows that the same molecule was created via more than 
one combination of transformations. 
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 Switch to table view by clicking the  button 

 

In table view the rows are sorted with the highest scoring idea at the top. Selecting a row will result in 
the compound being displayed within the Nova tab, along with its parent compounds and any 
compounds generated from it. Any compounds which are filtered out will be displayed faded-out to 
indicate that they were created but are not present in the final data set. (Hint: the penultimate wizard 
page, not used in this example, enables you to choose which filters, if any, to apply). 

24. What are the main differences between the compound with the highest score and the initial 
lead compound? 

Answer:________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

____________________________________________________________________________ 

25. There is a major drug in the list of newly generated compounds. Can you spot it? 

Answer:________________________________________ 
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 Using Nova’s Matched Series Analysis to generate new compound ideas 

 Controlling the different approaches for generating suggestions for matched series 

 Exploring Matched Series Analysis results 

This example uses a publically available set of Human Chymotrypsin Ki data and searches the ChEMBL 
pIC50 knowledge base to find matched series that indicate new substitutions with a high likelihood of 
improving the binding at Chymotrypsin. 

 Open the file Chymotrypsin_pKi.add by using the File -> Open menu. 

  

You will see a spreadsheet containing 115 structures and their measured affinities for Human 

Chymotrypsin C (in the column labelled pKi). 

 Change to the Nova tab and then the arrow button  at the bottom of the tab. 

 

 Select the Matched Series Suggestions option and click Next 
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In the dialogue box that appears, you can specify the column containing the property you wish to 
improve. In this case, the column we are interested in, pKi, is already chosen and we want to find 
suggestions that increase this value so this default option is also correct. 

 Select Next to continue. 

At this point you can change the limitations placed on the suggestions returned. In Matsy™ the support 
for a suggestion comes from the number of times it has been seen; the more frequent the occurrence 
of the order of the input series, the more likely it is that the suggestion will be an improvement. Hence, 
to find many examples in the ChEMBL knowledge base, the compared series are generally short. 

With SAR transfer, the support for a suggestion comes from a long series of derivatives that shows a 
consistent trend with that seen in the input data set. This example data set is too small to have matched 
series with the default minimum number of derivatives (8), so for this example we will decrease this 
limit. 

 

 Click on the Minimum length of matched series box in the SAR transfer section and change 

the value to 6 as shown in the image above. 

 Click the Next button to continue. 
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 Check all the boxes for the Matsy output as shown above and click Next. 

 Here you can choose structural filters to exclude certain chemical groups. In this case we 

will use the defaults, so click Finish to begin the matched series analysis. 

The suggestions are returned in a table with the Matsy based suggestions first, followed by the SAR 
transfer suggestions. The Matsy suggestions are ordered by the % that improve column and the SAR 
transfer are ordered by the Max Correlation column. When a row is selected in the data set the 
suggestion is displayed in the main Nova tab and the supporting evidence is shown in a table below it.  

 

SAR data from the input data set is in the first row (which is why the target and first substituent 
columns are empty) and the SAR data is ordered with the least active/desirable on the right to the 
most active/desirable on the left (as indicated by the colour coding in the table cells). 

The first row of the data set shows one of the suggestions that is most likely to improve the pKi which 
is the creation of the Bromine derivative. This suggestion is based on the order of activity seen for the 
hydroxyl, methoxy, and unsubstituted derivatives, at that position on the displayed scaffold, seen in 
the input data set. The Bromine substitution on this scaffold has the greatest weight of evidence 
suggesting that this might be worth investigating next.  

26. Which other variations on this scaffold might also be worth considering? 
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Answer:_________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________ 

Hint: Select the first row and the sort the data set by the scaffold column to show all the other 
suggestions for this scaffold ordered by the percentage of times that an improvement has been seen. 

27. Which of the suggestions resulting from the SAR transfer method has the strongest evidence 
that it may improve activity? 

Answer:_________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________ 

Hint: To see the SAR transfer suggestions, right click on the Max correlation column in the main data 

table and choose the Sort->descending menu item.   



  45 

 Comparing the 3D fields generated by compounds to identify key interactions 

 Screening new compounds against a known bioactive to look for novel potent compounds and 
identify opportunities for optimisation 

You have a 3D structure of a bioactive compound from your project, derived from a crystal structure of 
the ligand bound to CDK2, and a number of other active compounds. You would like to compare these 
active compounds to understand the underlying SAR and identify opportunities for further 
optimisation. 

In this example we will use the torch3D module to study 3D Field alignments with the known bioactive 
structure. Multiple, energy-minimised conformations are generated by torch3D which compares their 
3D shape and field patterns to find the best alignments to the reference structure. For each molecule 
the top-10 scoring alignments are calculated for detailed analysis and visualisation. A high Field Score 
indicates a better match of an alignment with the reference structure. It is not a guarantee that it will 
be potent, but helps to prioritise those compounds for more detailed investigation. 

 Open the data set CDK2.add 

 On the torch3D tab select the  button to start the torch3D wizard and define a new 
reference against which the new compounds will be compared. 

 

 On the first page of the Wizard, type in the name CDK2 Reference (this will be used as the column 
name in the data set where the results are displayed). 
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 Click the Next button and then load the reference molecule by clicking the Load file button and 
selecting the attached file CDK2 bioactive.sdf. The loaded structure will be displayed. 

 

 Click Next to (optionally) load a protein structure to define excluded volume - in this example 
we will omit this step. 

 Click Next to specify the speed of the calculations – in this case we will leave the selection as 
Normal and then click the Finish button. 

 The reference molecule will be loaded in 3D showing its field points and a new column will be 
added to the data set. 
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Now the reference has been set up we can carry out a field comparison against any compounds in the 
data set. 

 Select all the rows by clicking the button in the top left corner of the table and then click the 

 button to start the calculation. torch3D calculations run in the background and the results 
will appear in the table when it is completed. The field points of the reference are shown as 
polygons, those of the aligned compounds as spheres. 

 

(Note: If you select a compound that’s already queued, the  button will change to  
indicating that clicking the button again will remove the compound from the queue.) 

 Once the score has been returned, select a row to see that compound and its fields, 
superimposed on the reference molecule. Using the mouse you can zoom into and rotate the 3D 
molecules in order to see how their fields compare. You can explore the top 10 alternative 

alignments identified by clicking on  or  buttons in the “Alignment” column. 
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28. Many of the compounds are structurally similar to the reference compound. However, 
compound XXX-6 is from a different chemical class. What similarities may explain the similar 
activities of this compound and the reference?  

Answer:______________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________  

 Select the row containing compound XXX-4 and notice that the position of the pyrimidine in the 
fragment in the second alignment matches the reference very well. 

 

 Click the  button to see the molecule and the reference compound side-by-side. 
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Using the reference compound as a guide we can explore modifications to this fragment to better match 
its general shape and electronic profile. 

 First, try adding a phenyl group by switching to the Design tab 
and editing the original compound. Draw the molecule shown 

to the right and then click the  button to add this to our 
data set. 

 Now change back to the torch3D tab, select the row containing the new compound and click 

the  button to calculate its alignment with the reference.  

29. How does this new compound compare with the original in terms of its alignment?  

Answer:______________________________________________________________________

_____________________________________________________________________________ 

 Now change back to the Design tab and try substituting a 

phenol instead, as shown right.  Once again, click the  
button to add this row to the data set 

 Switch back to the torch3D tab and click the  button to 
calculate its alignment with the reference.  

30. Are there any alternative alignments to the phenol derivative which appear to give a better 
match in terms of the electronic properties? 

Answer:______________________________________________________________________

_____________________________________________________________________________   
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1. Which chemistry has the highest average potency? 

Answer: 2(arylcycloalkylamine) 1-indanol 

2. What is the identifier of the most potent compound?  

Answer: S5-34 

3. Which chemistry includes the majority of compounds with high potency, low MW and 
appropriate logP values? 

Answer: Aminotetraline 

 

4. All three compounds are very potent so on the basis of these three examples which chemistry 
type looks promising as a potential lead? 

Answer: Confirming our previous analysis, the aminotetraline S1-9 appears to offer a good 
starting point for lead optimisation, with high potency, low logP and low molecular weight. 

5. Which stacks appear to contain compounds with the best potency and range of logP values? 

Answer: Based on potency and logP alone, both the 2(arylcycloalkylamine), 1-indanol, and 
aminotetraline stacks contain a reasonable proportion of potent compounds and a good range 
of logP values. 

6. What are the most critical issues that should be addressed to significantly improve the chance 
of success of compound S3-23? 

Answer: Low solubility and high logP. 

7. Which compound has the highest score? 

Answer: S1-26 

8. Which chemistry contains the majority of the top 10 compounds? 

Answer: Aminotetraline 

9. Which other chemistries should we consider in the search for a high quality lead series? 

Answer: Both the aporphines and arylpiperazines have a number of promising compounds 

10. Which variations in chemical structure have the greatest impact upon the potency? 
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Answer: From this analysis we can see that substituents on the phenyl ring have a strong effect 
on the potency. For example, a para-methoxy substitution significantly decreases the potency, 
while addition of a methoxy in the ortho position has the opposite effect, increasing the potency. 
At the same time we can also note that adding steric bulk to the linker has a negative impact.  

 

11. Which groups at position R3 and linker L1 give the highest potency? 

Answer: at R3 and as the linker give the highest potency 

12. Which group at position R1 and linker combination give the highest stability against CYP3A4 
metabolism? 

Answer: at R1 and as the linker have the greatest stability 

13. Which compound is most likely to have a good balance of potency, metabolic stability and the 
other properties required by this project? 

 
Answer: S10-27 has the best overall balance of properties 

14. What effect does this have on the predicted hERG pIC50? 

Answer: The predicted hERG pIC50 decreases to 5.382 

15. What effect does this have on the overall predicted score? 

 Answer: Despite improving the hERG pIC50 the overall score has decreased to 0.1524 

16. Why? 
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Answer: The predicted blood-brain barrier penetration is now lower and this property is more 
important in terms of the overall score than the hERG pIC50 

17. What effect does this have on the predicted hERG pIC50? 

Answer: The predicted hERG pIC50 decreases to 5.366 

18. What effect does this have on the overall predicted score? 

Answer: The overall score increases slightly to 0.2525 

19. Complete the table for each compound inserting the CSL and the site(s) most likely to form at 
least 50% of products due to metabolism by CY3A4: 

Compound CSL Likely Site(s) of Metabolism 

S1-45 0.93 C17 (82%) 

S8-17 0.95 C18 (38%), C16 and C8 (22%) 

S6-31 0.83 C7 (35%), C21 and C22 (16%) 

 

20. Which of the above compounds is most likely to show an improvement in metabolic stability 
over S1-45? 

Answer: The CYP3A4 regioselectivity and metabolic landscapes for S1-45 and modified 
analogues are as follows: 

Compound 3A4 Regioselectivity Metabolic Landscape 

S-145 
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Analogue 1 

 

 

Analogue 2 

  

Analogue 3 

  

This suggests that Analogue 3 is likely to be metabolised the least if it is a substrate for 3A4. It is 
the only compound with no labile sites and has a lower CSL. 

21. Complete the table and then comment on the differences between the models: 

Comments: The set selection process introduces an element of randomness when splitting the 
original data into training, validation and test sets. However, looking at the statistics for the three 
models, all are likely to be reasonable and produce similar results. 
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22. Which is the best model and how does it compare with the others? 

Answer: Again, without using pre-split data, the model results can vary. However it is likely that 
one or two of the models correctly categorize the majority of the data. It is probable that some 
of the models produce identical results and as such would be equally useful.   

23. Comment on how well these models performed and which might be most useful when making 
decisions about which compounds to synthesize in the future: 

Comments: Both the best continuous and the best classification model produce good results 
and give good predictions for the additional data.  For use within a project, it would be advisable 
to use the continuous model because this model is accurate enough to give a better indicator of 
affinity than the classification model.  Therefore, if included in a scoring profile alongside ADME 
parameters the continuous model will be more helpful in differentiating between compounds 
when prioritising and selecting. 

24. What are the main differences between the compound with the highest score and the initial 
lead compound? 

Answer: The Glowing Molecule shows that the additional heteroatom present in the thiophene 
and pyrrole groups in the top scoring compounds has a positive effect on the Ki, significantly 
increasing the overall score. 

25. There is a major drug in the list of newly generated compounds. Can you spot it? 

Answer: The molecule generated in row 19 is actually the drug Duloxetine. 

 
26. Which other variations on this scaffold might also be worth considering? 

Answer: Whilst one might be surprised to find that Bromine is a suggestion, given the fact that 
the SAR shows that the smallest group is the most active in the series, this effect has been seen 
many times (over 56% of the 48 observations of this series) and may well be due to this group 
binding to a flexible hydrophobic area of a protein that can move to accommodate the larger 
bromine. The increased lipophilicity of the bromo-derivative may also help drive the increase in 
binding by hydrophobic collapse of the ligand with the protein in water. 

The chloro, tri-fluoro, methyl and fluoro substitutions are also recommended having being 
observed 40 times or more (chloro and fluoro more than 100 times). In over 30 percent of cases 
all of these have resulted in an improvement in activity for this series.  

27. Which of the suggestions resulting from the SAR transfer method has the strongest evidence 
that it may improve activity? 
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Answer: In the top suggestion you can 
see that the series of aryl derivatives 
from the input data correlates very well 
with the activities of derivatives at Rho 
Kinase.  

Given the improvement in activity seen 
in the input data set, in moving from the 
more hydrophobic aryls to the anisole, 
the suggested phenol follows that trend 
for more polarity. 

28. Many of the compounds are structurally similar to the reference compound. However, 
compound XXX-6 is from a different chemical class. What similarities may explain the similar 
activities of this compound and the reference? 

Answer: Despite the difference in chemical structure torch3D identifies a plausible alignment to 
explain the similarity in activity between XXX-6 and the reference, based on the similar field 
pattern (and hence interactions) generated by these structures (some are highlighted in the 
figure below). Given the commonality between these points, they may indicate important 
features to give potency against the target. 

 

29. How does this new compound compare with the original in terms of its alignment?  

Answer: The additional phenol group aligns very well with its counterpart in the reference 
compound resulting in a significant increase in the field score from 0.62 to 0.71. 
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30. Are there any alternative alignments to the phenol derivative which appear to give a better 
match in terms of the electronic properties? 

Answer: The second alignment shows a better match with the sulphonamide in the reference 
compound. 


